
ChartTamer Table Of Contents 
This help file is designed to provide you with a quick and easy way to get help with a ChartTamer 
question. If you have a question not covered here please check the readthis.1st file. This file constitutes 
ALL of the documentation provided with ChartTamer.    It is much easier to provide you with a concise on-
line document that allows you to quickly search for the topic you have a question about.

 IMPORTANT FILE INFORMATION! ChartTamer uses enhanced versions of files you may already 
have on your drive. For proper operation please READ THIS before you try to run ChartTamer for the first
time

 ChartTamer Uses Context Sensitive Help. To get help with a particular command or action, 
press F1 when the dialog box you have a question about is displayed, or when the menu item you have a
question about is highlighted.
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File Menu
This Index lists Help topics for the File Menu. 

New

Open

Import

Save

Save As

Save As A Bitmap

Print 

Exit - Special Notes



Edit Menu 
This Index lists Help topics for the Edit Menu. 

Chart Data 

Change Chart Type

Set Chart Colors
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Fonts Menu
This Index lists Help topics for the Fonts Menu. 

Set Chart Fonts



Options Menu
This Index lists Help topics for the Options Menu. 

Add A Bitmap Background

Chart Double Click

Quick Data

Toolbar

Clear Current Chart



 Special Chart Types
This section covers special chart types that require some additional information and data input 
considerations.

Polar Charts 

Scatter Charts 

High Low Close 

3D Line Charts 

Log/Lin Charts 



File New - Creating A New File
To create a new chart file follow these steps:

1. Select New from the file menu or press Ctrl + N

2. Lets suppose you want to chart the sales of Widgets for the past six months.    You would enter 1 in the 
data sets edit box. This will represent the monthly sales figures for the last six months 

3. Now enter 6 for the number of time periods or points that you would like to chart. This will be our 6 
month time period for the Widgets. Click on the OK button to continue...

The data entry spreadsheet is displayed. Navigating the Grid is vary easy.

4. When the focus rectangle is on the cell into which you want to enter data, all you have to do is start 
typing in your numbers or text in the case of a caption, label, or legend.    Press enter when done.    The 
maximum length for the numeric fields is 9999.99 or -9999.99 depending on your data you may need to 
add a left title to explain the scale.    The maximum length for text fields is 80 characters.    

 You can use your mouse to add data to different cells in the grid by doing the following:
1. Enter a value
2. Instead of pressing enter, move the mouse pointer to the cell into which you want the value to be 
placed. Click on the cell to add the value.



Opening A Chart File
To load a chart file from disk, select File from the main menu and choose Open, or press Ctrl + O. Select the 
file from the list box,    or use the directory list box to move to the location of your chart file. Only those files with 
the extension .CDF (Chart Data File) will be displayed in the list box. Alternately you can double click on the file
name to load the file.



Importing Data Into ChartTamer

You can import any ASCII text into ChartTamer quickly and easily.    Your text file MUST be in the following
format:

"123 343 456 456 556 445
445 323 677 322 200 150"
"2",6","1"

1. Begin with a quote " to start your data
2. Each data value MUST be separated by a TAB
3. The end of each data set MUST end with a Carriage Return and a Line Feed. (ASCII Chr$ 13)
4. Your last data set will end with the closing set of quotes"
5. The next value is the number of data sets, the number "2" above
6. The next value is the number of points, the number "6" above
7. The last value is the type of chart you want displayed when you open this file.
The following values correspond to the chart type:
1  2D Pie 
2 3D Pie
3 2D Bar
4 3D Bar

8. Save your data file with a CDF extension, for example SALES.CDF

Most database and spread sheet programs will export text that is Tab separated.    All you need to do is 
load it in your favorite editor and add the data set, point, and chart type info to the end of the file. 
ChartTamer comes with several sample data files that you can use as an example, or modify to fit your 
needs.



File Save and Save As
Choose File Save from the main menu, or press Ctrl + S.    If you were working on a file that was opened 
from disk the save will be automatic.    If this is a new file, the Save As dialog will be displayed so you can 
enter a new filename.



Save Chart As A Bitmap
ChartTamer allows you to save your chart to disk as a Windows Bitmap.    You can then include it in 
another program, or customize it further using a graphics program.



Print
This option will print the chart currently displayed to your printer. The program will determine the best way 
to print your chart.    If you have a Laser Printer you should choose the color or gray scale printer option.    
This will result in a very nice gray scale printed image.    The Monochrome printer setting will only be 
needed if you are using a Dot Matrix printer.

The print options determine whether or not to print a border on your chart.



Exit
This will end your current ChartTamer session.

 NOTE: You will notice that the close option is removed from the control menu in the upper right 
hand corner of the ChartTamer Window.    This prevents you from closing ChartTamer by double clicking 
on the control menu .    This was done intentionally to make sure that the Graphics Server will close 
when ChartTamer does.    If you closed ChartTamer from the control menu it would not be able to pass the
end program command to the graphics server program. 



Edit Chart Data 
Choose the edit data menu selection to add or edit data for your chart. You can also press the edit data 
button on the toolbar    

To enter data all you have to do is move the focus rectangle to the cell you want to edit and then just start 
typing.    Press Enter when you're done to add the data to the cell. 
See Also Navigating The Spreadsheet Grid 



Change Chart Type 
There are several ways to change chart types. You can double click on the chart, press Ctrl + T, or choose
Change Chart Type from the menu.



Set Chart Colors
You can easily set the individual colors for each chart element.    To change the colors choose set colors 
from the menu, press Ctrl + C or use the chart color button on the toolbar    These Chart Colors are 
available.



Bar Chart Options 
This allows you to change the type of Bar Chart to display.    The selections that are available for 3D only 
charts are clearly marked in the combo box.
You can choose the following BarTypes



Pie Chart Options 
This allows you to change the type of Pie Chart to display. You can select a variety of options including 
exploding sections of your pie chart.    Remember that pie charts use only the first data set. So when 
entering data keep this in mind so that set 1 will represent data you want to use in your pie chart. The 
following Pie Styles are available.



Area Chart Options 
This allows you to change the type of Area Chart to display. You can select from the following Area Chart 
Types



Gantt Chart Options 
This allows you to change the type of Gantt Chart to display.    
You can have the bars adjacent to each other or spaced for greater legibility.



Line Chart Options 
This allows you to change the types of lines available for line charts.    In addition it allows you to add 
statistical lines to your line charts.    Statistical lines are not available for all line chart types.    The program
will automatically disable the statistical line feature if it is unavailable for the chart you currently have 
selected.

You can use thick lines 3 pixels wide or thin lines 1 pixel wide.    In addition the following Line Styles are 
available. You also have a wide variety of Statistical Line Types available.



Set Foreground Background Colors 
This allows you to easily set the foreground and background colors of the chart.    The Foreground Colors 
will affect only the color of the labels, legends, and captions.    The Background Color will automatically 
adjust the chart area to a contrasting color. Click on the dialog box below for help with specific items.



Captions - Labels - Legends 
ChartTamer allows you to fully comment your charts through the use of Captions - Data Labels- and Data 
Legends.



Grid Style 
ChartTamer allows you to set the type of grid that is displayed on your chart.
Horizontal, Vertical, None, or Both



Fill Patterns
You can fill any pie, bar, area, and gantt chart with a pattern for each point. This is very easy to do, and 
ChartTamer will allow you to undo the fill options if you don't care for the results.

Click on a fill pattern and then choose the point and set that you want to fill. Click on OK to fill it.    You can
reset all patterns at anytime by using the reset button.    When finished click on Done to end the fill 
function.



Copy To Clipboard
This option lets you quickly copy the current chart to the Windows clipboard. You can then paste it into a 
word processing document, or a graphics program.



Set Fonts
ChartTamer supports the following fonts. Times Roman, Helvetica, and Courier.    This is adequate for 
most charts. If you need a special type face save the chart to disk as a bitmap and then use a paint 
program to add your fonts or other special effects.    The font sizes supported are from 50 to 500 pixels.    
You will need to experiment with the various sizes. The default size for the Title Caption is 200 and the 
other text it is 100.    These numbers will give you a starting point to work from.    The full range of type 
styles is supported, from normal to bold italic underlined.



Adding A Bitmap Background
One of ChartTamer's most powerful features is its ability to add any bitmap as a background to your chart.
Company logo's, scenic backdrops, or perhaps a bitmap that applies to the subject of your chart. If you ad
a large bitmap to the background of your chart it will take ChartTamer more time to re-draw your chart.



Double Click Functionality 
Double Click Mode is the default and is selected from the options menu. When the mode box displays 
Double Click you can change to any type chart by double clicking anywhere on the chart.    This makes 
changing chart types quick and easy.



Quick Data
One of ChartTamer's most powerful features is Quick Data.    When you choose Quick Data from the 

options menu, you enable this mode and it is reflected in the mode box.  

Now you can instantly change the data values for any point and set in your chart by clicking on it. The real
power here is that ChartTamer allows you to change single data element values on the fly WITHOUT 
affecting your permanent data.    It becomes a very flexible "What If" tool for graphical analysis.    
Remember that these data changes are made to the chart only and are not stored anywhere.    If you
want to make a change permanent ,choose edit data and enter the new value you want to use.

 Hint: when using Quick Data it is the easiest to use with a bar chart.    On line charts for example it 
can be very difficult to hit the exact point you want to change. The changes to the data are reflected 
throughout all chart types.



Toolbar Reference
Shown below is the tool bar for ChartTamer.    Click on each tool for a description of its function



Clear Current Chart

This option will clear and reset all of the current chart values. It will NOT delete the currently opened data 
file.    This option give you the opportunity to create a new chart and data file from the currently opened 
file.



Trouble Shooting Help
If you are having trouble with ChartTamer you have the following help options available to you.

Shareware Evaluation Users

You can get help by calling our BBS at 602-375-0531 (2400 Baud) or 602-375-9945    (9600 Baud)
Leave a message to the sysop regarding your problem. You will have an answer in a few days. 

You can Fax us with your problem at 602-375-9928.    We will return your answer by Fax only so be sure 
to include your fax number with your question.

You can leave a message in our compuserve mailbox.    Our CIS ID number is 72200,576

Registered Users

You can use the options outlined above, and you can also get direct phone help. Before you call for help 
YOU MUST HAVE YOUR REGISTRATION NUMBER READY. It will be the first thing we will ask you for 
when you call.

The tech support phone number is 602-375-9928 and is available from 9:00 am until 3:00 PM Monday - 
Friday. 

Please Note: Arizona is on Mountain Standard Time All Year Long. When daylight savings is in effect we 
are the same time as the West Coast. The rest of the year we are on the same time as Denver, 1 hour 
later than the west coast.



Accelerator Key Reference
Listed below are all of the keyboard shortcut keys. You might want to print this topic for future reference.
Action By Key Combination

Action Key Combination
New Ctrl + N 
Open Ctrl + O 
Save Ctrl + S
Edit Data Ctrl + D
Change Chart Type Ctrl + T
Change Chart Element Color Ctrl + C
Bar Chart Options Ctrl + B
Pie Chart Options Ctrl + P
Area Chart Options  Ctrl + A
Gantt Chart Options Ctrl + G
Line Chart Options Ctrl + I
Foreground/Background Colors Ctrl + K
Captions Labels Legends Ctrl + P
Grid Style Ctrl + R
Fill Patterns  Ctrl + F
Copy To Clipboard Ctrl + Ins



Important File Information
ChartTamer requires the following files that may already be on your drive. If so, you must replace them
with the files contained in the ChartTamer Archive.    Our versions of these files have added 
functionality that ChartTamer Requires.    These files will in no way interfere with other applications that 
may use them..      Listed below are the files you will need to look for and replace with the ones 
included with ChartTamer:

GRAPH.VBX
GSWDLL.DLL
GSW.EXE
THREED.VBX
These files may be located in your Windows System Directory, or perhaps they are in a different directory 
that is in your path.    You can use the Windows File Manager's "Search" function to locate these files.

In addition ChartTamer requires the Visual Basic 2.0 runtime DLL, VBRUN200.DLL It is included with 
your program and the setup program will install it for you.

 Failure to replace these files will cause ChartTamer to CRASH since older versions of these 
files don't contain functions that ChartTamer uses.



The Graphics Server- GSW.EXE
The Graphics Server Program is a support program that ChartTamer uses to calculate and draw its 
charts.    This program allows ChartTamer to do a much faster job of screen re-draws and chart 
calculations, giving you a more responsive program.    It closes out when you close ChartTamer.
You can confirm you have the correct version if the server has the same icon as ChartTamer.    If the icon 
does not look like the one in the caption of this help topic,    then you have an out of date version!  
Use The Setup program to copy the current version contained in the ChartTamer Archive to your Windows
System Directory!

 
NOTE: Do NOT close the Graphics Server Program while ChartTamer is running, if you do 
ChartTamer will LOSE ITS CHART DRAWING CAPABILITY. 



Exploding Pie Chart Sections 
ChartTamer gives you total flexibility over your pie charts. You can choose to explode a single section or 
all sections.    The reset button can be used at anytime to place all the pie sections back together. 



3D Line Charts 
3D Line Charts have their own special properties.    You can't fill them with a pattern or apply different line 
styles to them.    You can however change their color and the grid style.



Scatter Charts
Scatter charts differ from other charts in that they display the data points as symbols only on the chart.    
You can't apply normal line chart options to them but you can apply the statistical line options from the line
options dialog box.



Polar Charts
Polar Charts can use most of the options available from the Line Options menu. Items not available will 
be grayed out.



Log/Lin Charts
Logarithmic/Linear Charts can use most of the options available from the Line Options menu. Items not 
available will be grayed out.



High Low Close Charts

If you want to use a HLC Chart you will have to enter data in the following format.
Number of Sets = 3
Number Of Points = 3 or more
The data must be entered in the following order:
Set 1 will be the High value
Set 2 will be the Low Value
Set 3 will be the Close Value

 Note : Legend Text is NOT supported for HLC charts since only one chart may be shown on the 
axes.



Navigating The Spreadsheet Grid
Home Takes you to the start of the current row/column.
End Takes you to the last cell in a row/column.
Ctrl + Home Takes you to the very first cell in the grid
Ctrl + End Takes you to the vary last cell in the grid.
PgUp and PgDn Moves you up and down the grid.
Use the Left, Right Up, Dn Arrow keys move you from cell to cell. You can also you the mouse to move 
around the grid.



This is the New File Tool, select it when you want to create a new ChartTamer data file.



This is the File Open Tool, select it when you want to open an existing ChartTamer data file.



This is the Save Tool, You can press this at anytime to save your current data to disk.    If it is a new file 
then the Save As... dialog box will be displayed.    Enter your new data file name and press Enter of click 
on Ok.



This is the Bar Chart Options Tool. When you have a Bar Chart Active it will call the Bar Chart Options 
Dialog.    If another chart type is active it will be grayed out.



This is the Pie Chart Options Tool. When you have a Pie Chart Active it will call the Pie Chart Options 
Dialog.    If another chart type is active it will be grayed out.



This is the Area Chart Options Tool. When you have an Area Chart Active it will call the Area Chart 
Options Dialog.    If another chart type is active it will be grayed out.



This is the Line Chart Options Tool. When you have a Line Chart Active it will call the Line Chart Options 
Dialog.    If another chart type is active it will be grayed out.



This is the Gantt Chart Options Tool. When you have a Gantt Chart Active it will call the Gantt Chart 
Options Dialog.    If another chart type is active it will be grayed out.



This is the Chart Color Tool.    It allows you to change the individual colors of chart items.    On 3D bar 
charts it also allows you to define the shadow color of the bars.



This is the Foreground - Background color tool. Use it to set the foreground and background colors of 
your chart.



This is the Fill Tool. Use it to fill elements of your chart with a pattern.    It will be active for only those chart
types that are fillable.    For example you can't fill a line chart so it would be grayed out.



This is the Grid Tool.    Use it to set the type of grid displayed on the chart.    It will be grayed out if the grid 
style doesn't apply to a chart type.



This is the Captions, Labels, and Legends Tool.    Use it to enter the text that you want to display for these
options.



The is the Data Edit Tool.    Use this tool to edit your current data for the chart.



This is the Copy To Clipboard Tool.    Clicking on this button will copy the current chart to the Windows 
clipboard, where you could then paste it into another program.



This is the Help Tool.    Pressing it will display the ChartTamer Help Table Of Contents Section.

: NOTE: ChartTamer uses context sensitive help for every menu item and dialog box.    If you have 
a question about the current operation Press the F1 key.    Help for that particular item will be displayed.    
Pressing the Help buttons in the dialog boxes will display the ChartTamer Help Table Of Contents Section



This is the Mode Indicator. It shows you the current state of the Chart Options.    If you have the Quick 
Data option selected it will reflect that change.    It makes it easier to see which mode you have active at 
the present time.



The following Bar Chart Types Are Available.
Vertical Bars
Horizontal Bars
Stacked Bars", 2
Horizontal Stacked Bars
Stacked Percent Bars", 4
Horizontal Stacked Percent Bars
Horizontal Data Points ->(3D Only)
Vertical Data Points ->(3D Only)



The following styles are available for pie charts
Label Lines
No Label Lines
Colored Labels With Lines
Colored Labels Only
Percent Labels With Lines
Percent Labels Only
Percent Colored Labels With Lines
Percent Colored Labels Only



Standard - This positions the area sections next to each other in 3D mode and on top of each other in 2D
mode by absolute values.
Stacked - This positions the area sections on top of each other in 3D and 2D modes.
Percentage - This positions the area sections on top of each other in 3D and in 2D mode by percentage 
values.



Vertical
Symbols Only
Vertical With Symbols
Lines With Symbols
Horizontal and Vertical
Horizontal Vertical and Symbols



Mean
Minimum Maximum
Mean & Minimum Maximum
Std Deviation
Std Deviation and Mean
Std Deviation & Min Max
Std Deviation, Min Max, & Mean
Best Fit
Best Fit & Mean
Best Fit & Min Max
Best Fit, Min Max, & Mean
Best Fit & Std Deviation
Best Fit, Mean, & Std Deviation
Best Fit, Min Max, & Std Deviation
Apply All Lines At Once



Black Blue
Green Cyan
Red Magenta
Brown Lt.Gray
Dk.Gray Lt.Blue
Lt.Green Lt.Cyan
Lt.Red Lt.Magenta
Yellow White



ChartTamer Uses Context Sensitive Help. To get help with a particular command or action, press F1 
when the dialog box you have a question about is displayed, or when the menu item you have a question 
about is highlighted. Pressing the Help button in any dialog box will display the ChartTamer Help Table Of 
Contents.


















